
vDiff User Guide 



Versioning 

 Document version: v6.0.0-pre06. 

 For software version v6.0.x. 



Basic Applications 

 Switching. 

 Routing. 

 L4 filtering (firewall). 

 L4 routing. 



Advanced Applications 

 L4 switching (i.e., load balancing and fault 
tolerance) for AP servers. 

 L4 switching for WAN routers, i.e., 
outbound WAN load balancing. 



vDiff Models 

Model VDA100 VDA200 VDA300 VDA400 

Max connections 1M 2M 4M 8M 

Max targets 5 20 100 1000 

RAM requirement 2G 4G 8G 16G 

Compatible 
hypervisors 

VMware ESXi, MS Hyper-V, Xen. 



User Interfaces 

 Web UI 

– https://192.168.1.99/ 

– http://192.168.1.99/ 

 CLI 

– telnet 192.168.1.99 

– ssh 192.168.1.99 

– virtual machine console 

https://192.168.1.99/
http://192.168.1.99/


Defaults 

 Management IP：192.168.1.99/24, 

 One bridge, bridge_1. The first Ethernet 
port, e1, is on bridge_1. 

 Console is always on, https and ssh are on, 
http and telnet are off 

 One account with username/password = 
admin/admin. 



Emergency Account 
 Select “Emergency account” on the boot 

menu on the console. 



Emergency Account 
 Login with username = emergency and 

password = emergency during the initial 30 
seconds the system is booted. 

 Useful commands: 
– get all (show the current configuration) 

– save config from default to system (restore the default 
configuration) 

– get ip 

– get route 

– get dns 

– get account 



Restore Factory Defaults 

 Select “Factory default” on the boot menu. 



Web UI Layout 

Menu 

Page 



Command Line Interface 
(CLI) 



CLI Editing Keys 

 

 

Key name Function 

Control-A Jump to the front of the command. 

Control-B or LEFT Move the cursor backward one character. 

Control-C Cancel the command. 

Control-D or DELETE Delete the character on the cursor. 

Control-E Jump to the end of the command. 

Control-F or RIGHT Move forward one character. 

Control-H or Backspace Delete the character on the left of the cursor. 

Control-P or UP Browse the previous command in the history buffer. 

Control-N or DOWN Browse the next command in the history buffer. 

Control-R Clear the screen. 

TAB Help. 

Enter Execute the command. 

 

 



 CLI Usage 

 get ip 
 set ip append ipmask 192.168.1.99/24 

bridge bridge_1 
 If you see error messages, the command 

failed. Correct the command and try again. 
 Otherwise (no error message), the 

command is applied successfully, and new 
configuration is saved. 



Network topology before 
you install vDiff 

Clients 

Internet 

Firewall 

Clients 

Switch 

S1 S2 S3 S4 DB1 DB2 

Other 

servers 



Basic Networking models 
for AP load balancing 

 Transparent bridge mode 

 VIP bridge mode 

 Single-arm mode 

 VIP router mode 

 FW mode 



Mode 1: Transparent Bridge 
Mode 



Transparent Bridge (TB) Mode 

Configure vDiff as 

a bridge (i.e., L2 

switch) and place it 

in front of the AP 

servers. 

Clients connects 

as before to the AP 

servers (with IP or 

domain name to the 

AP servers), with 

the added benefits 

of load balancing 

and fault tolerance. 

Servers see the 

real source IP of the 

clients. 
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High Availability in TB mode 

Active 

Standby 

Switch 

DB1 DB2 S1 S2 S3 S4 

The HA link. 

See the high 

availability 

section for 

more 

information. 



Configuration in TB mode (1/4) 



(2/4) 

Notice this. 



(3/4) 



(4/4) 

Do not load balance 

connections from the 

administrator (you, 

10.10.10.123). So 

when you connect to 

say 192.168.1.32 

you are not load 

balanced. This helps 

debugging. 



Mode 2: VIP Bridge Mode 



VIP Bridge Mode 

vDiff is configured 

as a bridge (L2 

switch) and with an 

additional IP called 

the VIP 

(192.168.1.100 

here). 

Connect to the VIP 

and you get the load 

balancing. 

The AP servers 

see the original 

client IP(s). 
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HA in VIP bridge mode 

Active Standby 

Switch 

DB1 DB2 S1 S2 S3 S4 



VIP bridge mode config (1/3) 



Config (2/3) 

Add the VIP 

192.168.1.100. 



Config (3/3) 



Mode 3: VIP One-Arm Mode 



Mode 3: VIP One-Arm Mode 

Switch 
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Other 
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A Client connects 

to the VIP 

(192.168.1.100). 

vDiff connects to 

the selected server, 

with VIP as the 

source IP. 

The server 

processes the 

request and reply to 

VIP (which is vDiff). 

vDiff reply to the 

client. 



Characteristics 

 vDiff is acting just like a host, with one 
cable to the switch. 

 The AP server does not see the IP(s) of 
the clients. All the connections comes 
from the VIP. 



HA in one-arm mode 

Active Standby 

Switch 

DB1 DB2 S2 S1 S3 S4 



Config (1/3) 



Config (2/3) 

Add the VIP 

192.168.1.100. 



Config (3/3) 

Notice! 



Mode 4: VIP Router Mode 
vDiff is configured 

as a router and with 

an additional IP 

called the VIP 

(192.168.1.100 

here). 

192.168.2.1 is the 

gateway for the 

hosts in 

192.168.2.0/24 

The clients 

Connect to the VIP 

and get load 

balanced. 

The AP servers 

see the original 

client IP(s). 
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e1, bridge_1, MIP 

192.168.1.99, VIP 

192.168.1.100 

e2, bridge_2, 

192.168.2.1 



HA in VIP router mode 

Active Standby 

Switch 

DB1 DB2 S1 S2 S3 S4 



Config (1/3) 



Config (2/3) 



Config (3/3) 



5: VIP FW mode 

vDiff is configured 

as a router that 

separates the 

private and public 

networks. 

AP servers see 

the original IP(s) of 

clients. 

Public, e2, bridge_2, 

30.30.30.10, 30.30.30.11 

and 30.30.30.12 

S
1

 

1
9

2
.1

6
8

.1
.3

1
 

DB1 DB2 

Other 

Servers 

S
2

 

1
9

2
.1

6
8

.1
.3

2
 

S
3

 

1
9

2
.1

6
8

.1
.3

3
 

S
4

 

1
9

2
.1

6
8

.1
.3

4
 

Private, e1, bridge_1, 

192.168.1.1 



Tasks 

 vDiff is a simple firewall that separates the 
public and the private subnets. 

 30.30.30.10 is the source IP for outbound 
connections. 

 Connections to 30.30.30.11 (which is called the 
VIP) is load balanced to the AP servers. 

 Connections to 30.30.30.12 is redirected to 
some internal server. 

 See the configuration in the following for details. 



HA in FW mode 

Active Standby 

Switch 

DB1 DB2 S1 S2 S3 S4 



Config (1/5) 



Config (2/5) 

Ignore it. 



Config (3/5) 



Config (4/5) 



Config (5/5) 



High Availability 



HA operations (1/2) 

 With HA in operation, one of the vDiff is 
the “master” and the other is the “slave.” 
The master is responsible for the 
processing of all traffic, and the slave 
works in standby mode and monitors the 
status of the master via the HA links. 

 When the master fails, the slave will take 
over and become the new master. 



(2/2) 

 When you log into the UI (web or CLI), you are 
connecting to the master. When the configuration 
changes, it is transferred to the slave automatically. 

 The master and the slave shares all configurations 
and IP(s). There is no IP configured specifically for 
the slave. 

 You can check the status of the slave in the UI. With 
console, use “show hainfo”. With Web UI, check 
“View>System” and watch the “HA peer information” 
block. 



HA config 
 You can configure vDiff with zero, one or two Ethernet ports 

as the HA ports. 

 Use it in CLI (console, SSH, telnet) 

 tool halink 0 

 tool halink 1 e1 all-auto 

 tool halink 2 e1 all-auto e2 all-auto 

 Then reboot. 

 The involving two vDiff(s) should be configured separately 
with exactly the same halink config. 

 You can give the two vDiff(s) different hostnames to 
distinguish them easily. Use “tool hostname <name>” in the 
console. 



HA requirements 

 Two vDiff(s) should have same hardware 
(CPU, RAM, Ethernet ports, etc), same 
software version, and same halink config. 

 Save the configuration file in case 
something went wrong. 

 Link the HA port(s) of the two vDiff(s) 
BEFORE you power on the second vDiff. 



Verification of HA 

 Ping continuously an IP on vDiff. Usually you 
pick the IP used to connect to the web UI. 

 Power off the master. 

 The ping will continue after a few drops. 

 Log in the web UI and see that the old slave 
is now the new master. You may distinguish 
them by the serial numbers or the hostnames. 



Load Balancing Algorithms 



LBA: Randomized 

 Choose a target randomly. 

 Example: 3 targets A, B, and C, with 
weights 1, 3, and 2, respectively. Then the 
probability to target A, B, or C is 1/6, 3/6, 
and 2/6, respectively. 



LBA: Round Robin 

 Choose a target in round robin. 

 Example: 3 targets A, B, and C, with 
weights 1, 1, and 2. Then connections to 
this group will be delivered to A, B, C, C, 
A, B, C, C, and so on. 



LBA: Connection Rate 

 Choose a target that has minimum 
connection rate. 

 Connection rates are measured in 
connections per second, in the last few 
seconds. 



LBA: Bandwidth 

 Choose a target with minimum bandwidth 
consumptions. 

 Bandwidth consumption is measured in 
bytes per second, in both directions, in the 
last few seconds. 



LBA: Active Connections 

 Choose a target with the least number of 
active connections. 

 An active connection is an connection that 
is in vDiff’s connection table. 



LBA: Session Rate 

 Choose a target with minimum session 
rate. 

 Session rate is measured in sessions per 
second, in the last few seconds. 

 



LBA: Active Sessions 

 Choose a target with the least active 
sessions. 

 A active session is a session that is in 
vDiff’s session table. 

 



LBA: Response Time 

 Choose a target with probability  
reciprocal to the response time in its last 
health check. 



LBA: Hash 

 Choose a target with a static hash 
function. 

 The hash function takes as arguments the 
source and destination addresses of the 
connection and the weight of a target. 
Connections whose source and destination 
addresses are the same will be dispatched 
to the same target. 



Session Helper 



SH: None 

 This means that every connection get the 
opportunity to be load balanced. 



SH: By source and 
destination IP 

 The session table in vDiff keeps track of 
which target to use for a (src, dst) pair. 
When a new connection arrived, the 
session table is looked up. If an entry is 
found, use the stored target. Otherwise, 
do load balance and choose a target and 
new an entry in the session table about it. 



SH: By source IP 

 Ignore the destination IP in the session 
table described in the previous page. Use 
the source IP only. 



Health Check Method 



HCM: Ping 

 Use ping (IPv4 echo request) to check if a 
target is alive or dead (faulty). 



HCM: TCP connection 
establishment 

 Try to establish a TCP connection (the 
SYN, SYN-ACK, ACK handshake) to a 
target at the specified port. 



HCM: SMTP server 220 
response 

 Try TCP connection to a target at the 
specified port (usually 25) and wait for the 
SMTP 220 response (the hello response). 

 Useful for SMTP (sendmail) servers. 



HCM: HTTP page test (1/2) 

 Do health check by connecting to the specified 
TCP port (usually 80) and try to grab a HTTP 
page. 

 Example: If you provide a page /aux/health.php 
on the web server, set the “HTTP URL to check” 
as “/aux/health.php”, “HTTP text to match” as 
“200 OK” (this is usually the first line of text you 
see in the HTTP response) or a string that can 
be found on the page. 



(2/2) 

 HTTP host to check: The domain name of 
the web server, for example 
www.abc.com. Usually you can leave it 
blank. 

 HTTP additional header 1/2/3: supply 
additional HTTP header lines here. Usually 
they can be left blank. 



Target State Transition 



Target states 

 A target can be in one of the four states. 

 Up: The target accepts new connections. 

 Half-Up or Half-Down: The target accepts 
new connections that match some entry in 
the session table. 

 Down: The target is unable to accept new 
connections. 



State transition diagram 

Up 

Half-
Up 

Half-
Down 

Down 

A >= 1 

B >= 1 

C >= 0 

D >= 1 

E >= 1 
F >= 0 



Moving in the state 
transition diagram 

 A: Number of consecutive health check failures to move from 
Up to Half_Up. 

 B: Number of consecutive health check successes to move 
from Half_Up to Up. 

 C: Number of consecutive failures to move from Half_Up to 
Down. 

 D: Number of consecutive successes to move from Down to 
Half_Down. 

 E: Number of consecutive failures to move from Half_Down to 
Down. 

 F: Number of consecutive successes to move from Half_Down 
to Up 

 



Aggressive default 
configuration 

 The default configuration for the state 
transition counters, which is 1:1:0:1:1:0, 
is pretty aggressive. It catches the 
up/down events fast. 

 However, if you find unusually many 
up/donw logs in the “target health check 
log,” consider change the counters to 
something milder, for example, 
2:2:1:2:2:1. 



Action when one target is 
down 

 When a target is down, what to do to the 
packets of the existing connections to the 
target. The options are: 

 Continue: flow of the packets continues. 

 Drop: drop the packets. 

 Reject: drop the packets and send REJECT 
packets back to the senders. 



Action when all targets are 
down (1/2)  

 When all the targets in a group is unable 
to accept new connections, what to do to 
new connections. (This may due to that a 
target is down, the connection/session 
limit of the a target is reached, or the 
connection per session count is reached.) 

 This config is in “group parameter.” 

 The options are: 



(2/2) 

 Continue: forwarding the connection without 
load balancing. This is usually useful only to the 
transparent bridge mode. With other networking 
models, the connection may hit vDiff and show 
the management UI or be simply rejected. 

 Drop: the connection is dropped. 

 Reject: the connection is dropped and a reject 
packet is returned to the sender. 

 



Some measures to protect 
the targets 

 Connection limit (target configuration): The 
number of active connections a target can 
have. 

 Session limit (target configuration): The 
number of active sessions a target can have. 

 Connections per session limit (group 
parameter): The limit of the number of active 
connections of a session. 



Configuration examples for 
some popular services 



Example for the web service 

 TCP ports: “80,443” 

 Session help: S or SD 

 Health check method: HTTP 



Example for the SMTP 
service 

 TCP ports: “25” 

 Session help: None 

 Health check method: SMTP 

 

 



Example for the MS terminal 
service 

 TCP ports: “3389” 

 Session help: S or SD 

 Health check method: SYNACK at port 
3389 



Gracefully off-line a target 
for maintenance (1/5) 

 Four AP servers run smoothly. 



(2/5) 

 AP_32 is scheduled to upgrade the RAM, 
for example. So we change its mode to 
“half.” 

 New connections to old sessions on AP_32 
still go to AP_32, but new sessions are not 
to be created on AP_32. The active 
connections/sessions counters decrease. 



(3/5) 

 Like this. 



(4/5) 

 Eventually the counters are zeros (or close 
to zeros). It is time to off-line AP_32 and 
do your maintenance. 



(5/5) 

 After the maintenance. Change its mode 
back to “on.” 

 The counters of AP_32 increase and back 
to normal gradually. 



ARP request/reply test 
(1/3) 

 This is useful to detect duplicate IP(s) on 
the network. For example to test if there 
are duplicate IP(s) of the VIP 
192.168.1.100 on the network, do the 
following in web UI > Tools > Diagnostic. 



(2/3) 

 Normally, there should not be other hosts 
on the network that have the IP, so the 
result look like this: 



(3/3) 

 Otherwise, you will see something like 
this, indicating some duplicate IP. 



Filters and the processing of 
connections 



Processing of connections 

Filters 

L4SW 
(Load 

balance) 

Input 
interface 

Output 
interface 

Log 
DNAT 

Routing/Bridging 
SNAT 

Management 
UI 



Basics (1/2) 

 Every new connection travelling through vDiff is 
processes by the filters. 

 Start from the first rule of the table marked as 
“root table” and “flow” through the rules one by 
one. 

 The connection is matched against the rule. If it 
matches, the action is taken. 

 Depending on the action it takes, the connection 
may (1) leave the filters all together, (2) be 
dropped, or (3) “flow” the following rules. 



(2/2) 

 At the end of a non-root table. The flow 
resumes at the calling rule. 

 At the end of the root table, the connection will 
be given to the L4 switching module, which 
matches the connection against the groups. 



The matches 

 Input interface. 

 Source IP. 

 Destination IP. 

 Protocol: None, TCP, UDP, or ICMP. 

 TCP/UDP source and destination port. 

 Forwarded from <ip>. Match if the source MAC 
address of the connection is equal to the MAC of 
<ip>. Useful to see if the connection is from 
some gateway (router) specified by <ip>. 



The actions (1/6) 

 CONTINUE. A dummy action that does nothing. 
Flow the next rule. 

 LOG <text>. Emit a entry to the “connection 
log” along with the <text>. Flow the next rule. 

 ACCEPT. Leave the filters all together. The 
connection will be processed by the L2/L3 
modules of vDiff. It goes to the management UI 
if appropriate. But it will NOT be processed by 
the L4 switching module. 

 



(2/6) 

 DROP. Drop the connection. It is fed to 
“the blackhole.” 

 REJECT. The same to “DROP” and a reject 
packet is returned to the sender. 

 CALL <table>. Jump to <table> (and flow 
the first rule). 

 RETURN. The flow of the connection 
resumes at the calling rule. 

 



(3/6) 

 L4SW log on. Turn on the “L4SW log flag.” 
The flow continues. 

 L4SW log off. Turn off the “L4SW log 
flag”. The flow continues. 

 Admin allow. Turn on the “admin allow 
flag.” The flow continues. 

 Admin deny. Turn off the “admin allow 
flag.” The flow continues. 

 



(4/6) 

 SNAT <ip>. Replace the “SNAT mark” 
with <ip>. The flow continues. 

 DNAT <ip>. Replace the “DNAT mark” 
with <ip>. The flow continues. 

 DNAT <ip> <port>. Replace the “DNAT 
mark” with <ip> and <port>. The flow 
continues. 

 



(5/6) 

 L4SW <group>. Feed the connection to 
the load balance <group>. If it is not 
processed by <group>, the flow 
continues, otherwise, leave the filters all 
together. 

 Session help with source IP override <ip>. 
Replace the “session help source ip mark” 
with <ip>. The flow continues. 

 



(6/6) 

 Session help with source IP mask 
<mask>. Replace the “session help source 
ip mask” with <mask>. The flow 
continues. 

 REPLY_GW <ip>. Replace the “reply 
gateway mark” with <ip>. The flow 
continues. 



Admin UI access 



(1/2) 

 There are several administrative user 
interfaces: http, https, telnet, and ssh. 
They can be activated/deactivated 
individually by: 



(2/2) 

 By default, admin UI is allowed from all 
IP(s). You can allow connections only from 
hosts in 10.0.0.0/8, as follows. 



L4SW (load balancing) logs 



(1/2) 

 By default, the L4SW log is off. You can 
enable it as follows. 



(2/2) 
 And you can fine tune it, for example log 

only connections from 192.168.2.0/24, like 
this: 



WAN load balance 



Network topology 

R1 R2 

LAN 

192.168.2.1 

DMZ 

192.168.3.1 

192.168.1.1 

WAN 1 

1.1.1.254 

WAN 2 

2.2.2.254 

Web 192.168.3.5 

192.168.1.2 

1.1.1.1 & 1.1.1.5 2.2.2.1 & 2.2.2.5 



Tasks (1/2) 

 Outbound load balancing. For  connections 
from 192.168.x.x to Internet, load balance 
on WAN 1 and WAN 2, by doing so, SNAT 
to 1.1.1.1 for WAN 1 and 2.2.2.1 for WAN 
2, respectively. 



Tasks (2/2) 

 Map public IP(s) to internal services. In 
this example, map 1.1.1.5 and 2.2.2.5 to 
the internal web server at 192.168.3.5. 



Config (1/5) 



(2/5) 



(3/5) 



(4/5) 



(5/5) 



vDiff installation 



install.zip 

 You are supplied with an install file 
install.zip, with the following contents: 

install 

install/00readme.txt 

install/install_hyperv 

install/install_hyperv/disk.vhd 

install/install_vmware 

install/install_vmware/disk.vmdk 

install/install_vmware/vdiff.ovf 

install/install_xen 

install/install_xen/config_sample.1 

install/install_xen/config_sample.2 

install/install_xen/disk.bin 

 



VMWare installation 



Sample environment 

 This document is prepared with Vmware 
ESXi-6.5.0 Host Client web UI. 

 Extract install.zip and look into the 
install_vmware directory. 



Create a VMWare ESXi VM 
from OVF and VMDK files 



Select “Deploy a virtual machine 

from an OVF or OVA file.” 



Give a name to the new VM and upload the 

ovf and vmdk files. 



Select a storage you prefer. 



Attach e1 to the default port group 

“VM Network” or whatever port 

group you like. 



Click “Finish” and wait for the vmdk file 

to upload. 



You can log into the console with 

username/password = admin/admin. 

Enter the command “show sysinfo”. 



Assign MAC address 
 Note the MAC address shown in the “HW 

setup” line. In this sample, its 
36:aa:36:00:00:00. 

 “Power off” the VM and “Edit” its settins. 

 Expand “Network Adapter 1”, select the 
“MAC address” line and change it from 
“Automatic” to “Manual” and enter 
“36:aa:36:00:00:00” in the next field. 

 (Cont at the following page.) 



Click “Save” when you are done. 



Power on the VM and login the console 

and “show sysinfo”. Check that the 

“#BAD_MAC” is gone in the License line. 



At this stage, you should be able to 

connect to the web management UI at 

https://192.168.1.99. Username/password 

is the same admin/admin. 



Request for up-to-date 
license 

 See the chapter “Request for up-to-date 
license” to complete the installation 
process. 



Creating a Hyper-V VM 



Extract disk.vhd 

 Extract install.zip and locate disk.vhd 
(install/install_hyperv/disk.vhd) 

 Save disk.vhd somewhere in the Hyper-V 
host. 



 “New” a “Virtual Machine” in “Hyper-V 
Manager.” 

 



 Give it a name. 



 Specify “Generation 1.” 



 Give it 2000MB of memory for VDA100. 
(Check the spec page for other models.) 



 Connect to some virtual switch. 



 “Use an existing virtual hard disk” and specifly the 
extracted disk.vhd. 



 “Finish” the creation of the new virtual 
machine. 



 Start (power on) the new VM and login with username/password = 
admin/admin. 

 Enter the command “show sysinfo”. 



Assign MAC address 

 First we must resolve the “#BAD_MAC” in 
the “License” line. 

 Record the MAC address given in the “HW 
setup” line. In this example, it is 
36:aa:36:75:24:90. 

 “Turn off” the VM and edit its “Settings”. 

 Expand “Network Adapter” and click 
“Advanced features”. 



Cont. 

 Click “Static” and enter the MAC supplied 
in the previous step. 

 Check “Enable MAC address spoofing”. 

 Click “OK”. 

 See the figure in the following page. 





 Start the VM again and login the console. 

 “show sysinfo” and verify that “#BAD_MAC” is 
gone. 



Request for new license 

 However, this time, it show “#EXPIRED” 
which means that the license is expired. 

 Please see the chapter “Request for new 
license” to resolve it. 



Creating a Xen DomU 



Install files 

 Related files in install.zip are: 

install/install_xen/disk.bin 

install/install_xen/config_sample.1 

install/install_xen/config_sample.2 

 



 Use config_sample.1 as the starting point. 
Edit it with the following notes: 

 Memory size: it is 2000 in the sample. 
Change it to your model. 

 vif bridge name: bridge0 in the sample. 

 Disk file location: /home/xen/vdiff/disk.bin 
in the sample. 

 Boot vdiff with something like “xl create -c 
config_sample”. 

 Check config_sample.2 for additional 
Ethernet ports. 



Request for new license 



 Log in the web management UI. 

 Go to the “Tools > System” page. 

 Click “Request for up-to-date license”. 

 You will see “200 Operation completed 
successfully. Please check email.” 

 Check you email. and download 
“upgrade_license.bin” 

 Upload the file in “Upload kernel/license” 
block in “Tools > System” page 

 Reboot 



 Log in the system and check “System 
information” block in “View > System info” 
page. 

 Check that “#EXPIRED” is gone in the 
“License” line. 

 Also check that your model name is 
correct in the “Model” line. 


